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Converting from Principia to Advisor 
Workstation: The Clients & Portfolios Module 
OverviewThis manual will assist in your transition from Principia to Advisor Workstation. It discusses 
key elements you’ve worked with in the Portfolio mode of Principia, and explains how to 
perform equivalent functions in Advisor Workstation.

The fact that Principia served as the original basis of Advisor Workstation should encourage 
you that you will quickly be able to learn this new tool and use it in your practice.

The following topics are covered in this manual:

 × Understanding the Features and Layout of the Clients & Portfolios Module
 × Exporting Clients and Portfolios from Principia
 × Importing Clients and Portfolios to Workstation
 × Creating Clients in Advisor Workstation 
 × Creating Groups in Advisor Workstation 
 × Creating Portfolios in Advisor Workstation 
 × Working with Custom Benchmarks 
 × Generating Portfolio Reports in Advisor Workstation, and
 × Other Differences Between Advisor Workstation and Principia.
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Reviewing the organization of clients and portfolios in Principia
Reviewing the 
organization of 
clients and portfolios 
in Principia

In Principia, the Advisor Palette was organized so you could construct multiple 
portfolios and save them under a single client. The Advisor Palette in Principia had the 
following levels:

 × Practice
 × Client
 × Portfolio, and
 × Holdings.

For example, if a client had an IRA account and a taxable account, you could create two 
separate portfolios for the two accounts, but keep them under the same client name. 

How do clients, 
groups and portfolios 
work in Advisor 
Workstation?

In Advisor Workstation, the Clients & Portfolios Module allows you to manage your 
clients and their holdings. You can see not only a list of all clients at once, but also all 
portfolios. An advantage of Advisor Workstation over Principia is that you can combine 
clients into Groups for householding, track demographic information (e-mail, address, 
phone, etc.) for your clients, and create asset allocation models. 

Practice

Portfolio

Holdings

Client
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Understanding the Features and Layout of the Clients & Portfolios Module Overview
Understanding the Features and Layout of the Clients & Portfolios Module

OverviewThis section explains various aspects of the interface in the Clients & Portfolios Module. 
You’ll learn not only where to find various navigation controls, but also features 
available to you in this module.

What can I create 
in the Clients & 
Portfolios Module?

In Advisor Workstation, you can create the following items:

 × Clients
 × Groups (a collection of clients and accounts)
 × Portfolios
 × Client Plans (which includes a forward-looking wealth projection tool)
 × Model portfolios (without having to first create a client or group record)
 × Asset Allocation models
 × Custom Benchmarks
 × Advisor-defined securities
 × Alerts for portfolios
 × Lists of clients, groups or portfolios
 × Searches for clients, groups or portfolios, and
 × Custom views for the pages in the Clients & Portfolios Module. 

How do I access 
the Clients & 
Portfolios Module?

To access the Clients & Portfolios Module, you can use either the tab at the top of the 
screen, or click on any page under the Clients & Portfolios Module in the left-hand 
navigation pane.

 Note: Clicking the Clients & Portfolios tab at the top of the screen brings you to the Groups 
page. Clicking a page in the left-hand navigation pane brings you directly to that page.

Click this tab to access
the Clients & Portfolios Module

You can also click the
name of an item in this
list to move to that page
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What are the parts of the Clients & Portfolios Module interface? Understanding the Features and Layout of the Clients & 
What are the parts of 
the Clients & Portfolios 
Module interface?

This section orients you to the Clients & Portfolios Module’s interface, and explain how 
you can best navigate through it.

Letter Name Description

A
Clients & Portfolios 
drop-down field

This field allows you to choose another page within the Clients & Portfolios 
Module, such as Groups, Clients, Portfolios, etc. If the left-hand navigation 
area is collapsed, as shown in the screenshot above, this field allows you 
to visit other parts of the Clients & Portfolios Module without having to 
expand the left-hand navigation pane.

B View field
This field allows you to select a pre-built view, or a custom view you have 
created. The items you see here depend on the whether you viewing 
clients, groups, or portfolios.

C Find field
This field allows you to look for a record (client, portfolio, etc.) on the page 
you are viewing.

D
Saved Searches 
and Lists field

This drop-down field shows you the lists and searches saved in the Clients 
& Portfolios Module for the page (Groups, Clients, etc.) you are viewing. 

E Spreadsheet area
The main area of the screen, containing rows and columns of data relative 
to the type of record you are viewing.

F Vertical scroll bar Use this to scroll up and down through the rows displayed on a page.

G
Page selector and 
Page icons

Shows you which page you are on among all pages available. The Page 
Next/Previous Page icons move you one page at a time, or you can type in 
a page number to go to, or move to the last page or first page in a set.

H Horizontal scroll bar Use this to scroll left or right, in order to see additional columns.

A
B C D

E F

GH
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Exporting Clients and Portfolios from Principia Overview
Exporting Clients and Portfolios from Principia

OverviewThis section describes the steps necessary to export client and portfolios from Portfolio 
Mode. You can export all of the portfolios currently in the Advisor Palette, select 
specific clients and export the portfolios for just those clients, or hand pick individual 
portfolios for export.

Before you export files from Principia, note the following important points: 

 × portfolios are exported as .xml files
 × scheduled portfolios can be exported, but Advisor Workstation does not 

track transaction information, and
 × the default location for the files when exported is: 

Program Files\Morningstar\Principia\Users\User.

How do I export the 
entire Advisor Palette?

To export all portfolios from the Advisor Palette, do the following from Portfolio Mode:

1. In the Advisor Palette, right-click Practice, then click Export Advisor Palette... The 
Export Portfolio dialog box opens.

2. In the File name field, type a name for your exported file. 

 If you'd like to export to an area other than the default location, click the Save in drop-down 
field to specify a different location.

3. In the Export Portfolio dialog box, click Save. A dialog box opens, confirming the 
successful export of your files.

4. Click OK to clear the confirmation message.

Select this option

Use the drop-down field to 
navigate to location of your 
choice to store the .xml file
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How do I export selected clients from the Advisor Palette? Exporting Clients and Portfolios from Principia
How do I export 
selected clients from 
the Advisor Palette?

If you’d like to export only selected clients from the Advisor Palette in Principia, do the 
following from Portfolio mode:

1. In the Advisor Palette, click once on a client name to select it.

 To select, multiple client names, use <SHIFT>+click to select multiple consecutive clients 
(portfolios will be selected as well), or use <CTRL>+click to select non-consecutive clients.

2. Right-click on a selected item, and from the menu that appears, choose Export 
Client’s Portfolios. The Export Portfolio dialog box opens.

3. In the File name field, type a name for your exported file. 

 If you'd like to export to an area other than the default location, click the Save in drop-down 
field to specify a different location.

4. Click Save. A dialog box opens, confirming the successful export of your files.
5. Click OK to clear the confirmation message.

Select this option from 
the right-click menu
6 Version 



Exporting Clients and Portfolios from Principia How do I export an individual portfolio from the Advisor Palette?
How do I export an 
individual portfolio from 
the Advisor Palette?

To export individual portfolios from the Advisor Palette, do the following:

1. In the Advisor Palette, double-click a portfolio to open it.
2. Right-click the portfolio name you just opened.
3. From the right-click menu, choose Export Portfolio…. The Export Portfolio dialog box 

opens.

4. In the File name field, type a name for the portfolio you are exporting. 

 If you'd like to export to an area other than the default location, click the Save in drop-down 
field to specify a different location.

5. Click Save. A dialog box opens, confirming the successful export of your files.
6. Click OK to clear the confirmation message.

Select this option from
the right-click menu
Version 1.0 7



Overview Importing Clients and Portfolios from Principia
Importing Clients and Portfolios from Principia

Overview Advisor Workstation offers you the ability to import client and portfolio files from 
Principia, saving you the time and effort of manually re-entering this information.

Before you import the file, note the following important points:

 × Advisor Workstation imports all portfolios as Quick Portfolios; no transaction 
data is recorded

 × Advisor Workstation limits the number of holdings per portfolio to 250; any 
holdings above this limit are ignored, and

 × Principia client files are imported as a Group in Advisor Workstation. Once 
the information has been brought into the system, you can manually convert 
the Group to a Client, if necessary.

How do I import 
client data into 
Advisor Workstation?

 To import holdings from Principia, do the following in Advisor Workstation:

1. From the menu bar at the top of the screen, select File...Import...From File. The Import 
Portfolio dialog box opens.

 Note: You do not need to be in the Clients & Portfolios module in order to access this function.

2. Click Browse... to navigate to the directory where the XML file is saved. The Choose File 
to Upload dialog box opens.

  The default file location is: Program Files\Morningstar\Principia\Users\User

Click here to open the file 
you exported from Principia
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Importing Clients and Portfolios from Principia How do I deal with an unrecognized security during the import process?
3. Navigate to the folder where the .xml file you exported from Principia was saved.
4. Select the file you want to import, then click Open.
5. The dialog box is populated with client, portfolio, and holding information. To import all 

clients, portfolios, and holdings in the file, check the Select All box. Otherwise, check 
the boxes for the items that you want to import.

6. Click Import. A dialog box confirms the number of items imported. 
7. Click OK.
8. Click Close to exit the import dialog box.

How do I deal with 
an unrecognized 
security during the 
import process?

When using the importing feature with Advisor Workstation 2.0, you might occasionally 
need to map an unrecognized security. 

To map an unrecognized security, repeat steps 1-5 above, then do the following:

1. Click Import. A warning box appears indicating that the import process completed with 
unrecognized securities.

2. Click OK.
3. In the Edit Security Mappings dialog box, click the Security Type field for the 

unrecognized security.
4. From the drop-down list that appears, select an option.
5. Repeat steps 3-4 for each unrecognized holding you need to map.
6. Click Save.
7. Click OK to confirm the import process was complete.

 If there is a certain security you do not want to bring into client portfolios, leave the Mapped 
Security column blank for that holding. The system will remember the empty mapping, 
meaning you will not have to make this selection in future imports.

After selecting the exported 
.xml file, the client and portfolio 
information appears here
Version 1.0 9



Overview Creating Clients in Advisor Workstation
Creating Clients in Advisor Workstation

Overview This section explains the following:

 × the information you can capture about a client
 × the number of clients each user can create, and
 × how to create and edit a client record.

How does creating 
a client file in 
Principia compare with 
creating a client in 
Advisor Workstation?

When you created a client file in Principia, you selected File...New Client from the 
menu bar and entered a name for the file in the File name field of the Select Client File 
dialog box. You could also right-click Practice in the Advisor Palette to launch the 
Select Client File dialog box. Biographical information for a client could not be entered 
when you prepared a client file in Principia.

When creating a client, in Advisor Workstation, you can capture general demographic 
information such as first name, last name, gender, birth date and marital status. You 
can also capture contact information related to address, e-mail and phone numbers. 

 The First Name and Last Name fields are the only required fields; all others are optional.

How many clients 
can I create in 
Advisor Workstation?

In Advisor Workstation, each user can create up to 1,000 client records.

The file name entered in the

 
File name field is opened
in the Advisor Palette
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Creating Clients in Advisor Workstation How do I create a client in Advisor Workstation?
How do I 
create a client in 
Advisor Workstation?

You can create a client record in Advisor Workstation from any of the following areas:

 × in the Quick Start widget on the Home page, click the Client link 
 × the menu bar at the top of the screen (by selecting File…New…Client), 

or
 × above either the Groups or Clients spreadsheet areas, by clicking the New 

Client icon.

Regardless of the method you choose to get started, the Client File dialog box opens. 
To create a client, do the following:

1. Enter information on the General Information tab. Remember, First Name and Last 
Name are required.

2. Click the Contact Information tab to record more information about the client.
3. Once all of the information has been entered, click Save.
4. To close the dialog box, click Close.

Filling out the Contact Information 
tab can make it easier to later 
search for clients and create lists
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How do I edit a client’s record in Advisor Workstation? Creating Clients in Advisor Workstation
How do I edit 
a client’s record in 
Advisor Workstation?

If you need to edit a client’s record—either to input new information or change existing 
data—you can use one of the following methods from the Clients page:

 × click once on the client, then use the menu bar at the top of the screen to 
select File…Open/Edit

 × click once on the client, then click the Open/Edit icon above the 
spreadsheet area, or

 × right-click on the client, and select Open/Edit from the right-click menu.

Regardless of the method you choose to edit the record, the Client File dialog box 
opens. From here, you can enter or change any information you need to, then 
click Save.

1

3

2
Note the options you 
have for editing a
client’s record
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Creating Groups in Advisor Workstation Overview
Creating Groups in Advisor Workstation

OverviewThis section explains the following:

 × why it’s beneficial to create a group
 × how many groups can be created by each user
 × how to create a group
 × how to add new clients to an existing group, and
 × how to associate new portfolios with a group.

What are the benefits 
of creating a group?

A feature that exists in Advisor Workstation, but not in Principia, is the concept of 
working with groups. Working in a group in Advisor Workstation allows you to 
household members of the same family, or link together similar types of clients.

 Note: You must create a client record before it can be joined to a group.

How many groups 
can I create?

You can create up to 500 groups. Each group can have up to 21 clients associated with 
it, and up to 150,000 portfolios.

How do I 
create a group?

You can create a group in Advisor Workstation by doing one of the following:

 × from the menu bar, select File…New…Group, or 
 × from the Home page, click the Group link in the Quick Start widget.
 × From the Clients & Portfolios module, go to either the Groups or Clients 

page, and click the New Group icon above the spreadsheet area.

1

3

2

You have multiple options 
for creating groups
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How do I create a group? Creating Groups in Advisor Workstation
1. When the Group File window opens, enter a name for the group.
2. All other fields are optional, but adding this information will help you later when you want 

to sort, search and create lists of groups.

3. On the Group File window, click the Clients tab.
4. In the Client Name column, type the name of a client to add to this group. 
5. From the Designation column, select an option. 

 Note: Each group can have only one Primary client. 

6. Repeat steps 4-5 for each group member.
7. Click Save.

The more information you 
enter here, the easier it will 
be later to search, sort 
and create lists of groups

Remember to set a 
Designation for each 
member of the group
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Creating Groups in Advisor Workstation How do I add clients to a group?
How do I add 
clients to a group?

Existing clients can be added to a group when the group is created, but if you create a 
client record after the group has been created, you can add those clients to a group by 
doing the following:

1. After creating the client and group records, go to the Groups page in the Clients & 
Portfolios Module.

2. Check the box next to the group you want to associate the client to.
3. Click the Open/Edit icon above the spreadsheet area. The Group File window opens. 
4. On the Group File window, select the Clients tab.
5. In the next available row, click once in the Clients field. 
6. Type the name of the client, and select its name. 
7. Enter the Designation for the client.

 Note: Each group can have only one Primary client.

8. Click Save.

How do I associate a 
portfolio with a group?

You can associate a portfolio with a group, rather than a client, but if a portfolio is saved 
to a client, and the client is saved to a group, you do not need to also save the portfolio 
to the group; it will be automatically linked to the group via the client. 

For example, if you are using the Portfolio Report Builder tool to generate reports for a 
group, all portfolios associated with clients in the group will appear when you search 
for the group’s name.

If you are creating the portfolio, you can save it to a group by doing the following:

1. At the top of the Quick Portfolio window, click Save. The Save dialog box opens.
2. In the Save dialog box, type the name of the group in the To Group field.
3. Click once to select the group when its name appears.
4. Click OK. The portfolio is now saved to the group.

If you already created a portfolio (this could also be a model portfolio), and later want to 
associate it with a group, do the following:

1. Go to the Portfolios (or Model Portfolios) page in the Clients & Portfolios module. 
2. Check the box next to the portfolio you want to associate to a group.
3. Click the Open/Edit icon above the spreadsheet area. The Quick Portfolio window opens. 
4. At the top of the window, click Save As. The Save As dialog box opens. 
5. In the To Group field, type in the name of the group you want to associate the portfolio 

with.
6. Click once to select the group when its name appears.
7. Click OK. The portfolio is now saved to the group, in addition to either the client or as a 

model portfolio (depending on how it was first saved).
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Creating Portfolios in Advisor Workstation

Overview This section explains the following:

 × what kind of information you can capture in a portfolio
 × the number of portfolios each user can create
 × the number of holdings allowed in a portfolio
 × the difference between creating a client vs. a model portfolio, and
 × how to create a portfolio.

What are the 
differences between 
building portfolios in 
Principia compared to 
Advisor Workstation?

Advisor Workstation allows you to create what is known as a Quick Portfolio, where 
you enter dollars, shares, or percentages for the holdings in the portfolio. In Principia, 
you could create an Unscheduled Portfolio to allocate dollars, percentages, or 
shares into a portfolio. 

Note the options for 
entering a portfolio’s
allocation in Principia
16 Version 



Creating Portfolios in Advisor Workstation What kind of portfolio information can Advisor Workstation capture com-
You could also create a Scheduled Portfolio which allowed you to account for each 
holding in a portfolio, complete with tax rates, loads, and systematic investments and 
withdrawals.

 Although Advisor Workstation does not have this window, its Hypothetical tool is a close 
substitute.

What kind of portfolio 
information can 
Advisor Workstation 
capture compared to 
Principia?

Although both applications allow you to enter positions (securities and values) for a 
portfolio, Advisor Workstation provides the option to label the portfolio as being a 
401(K), IRA, etc., and indicate any fees associated with the portfolio. 

Advisor Workstation also allows you to indicate whether it is an actual or proposed 
portfolio, and whether the value of the portfolio should be included in the totals for a 
client.

How does portfolio 
tracking in Advisor 
Workstation compare 
to Principia?

Both systems provide similar tracking methods for portfolios, however, they are labeled 
differently in each program.

In Principia, you could do one of the following:

 × Keep shares static, but update dollars. The equivalent option in Advisor 
Workstation is a Floating portfolio, where the value changes with the market 
value of the portfolio’s holdings.

 × Keep dollars static, but update shares. The equivalent option in Advisor 
Workstation is a Fixed portfolio, where the number of shares are adjusted to 
reflect the price of the securities in the portfolio. This is most often used 
with Model Portfolios.

Use the Other Options tab
to enter tax, fees and
reinvestment assumptions
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How many portfolios 
can I create in 
Advisor Workstation?

Each user can create a total of 150,000 portfolios. This includes both portfolios for 
clients, groups and model portfolios. Principia could store 250 portfolios.

How many portfolio 
holdings can Principia 
store compared to 
Advisor Workstation?

Principia could store up to 500 holdings per portfolio, while Advisor Workstation can 
handle 250 holdings per portfolio.
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How does creating a 
portfolio in Principia 
compare with creating a 
portfolio in Advisor 
Workstation?

In Principia, you could create a portfolio from the New icon, or by selecting File...New 
from the menu bar. After you selected the portfolio type, you added holdings and then 
allocated them accordingly. Another option was to first save a Client file, and then 
select Yes when asked whether you wanted to create a portfolio for the client. 

When you are working in Advisor Workstation a portfolio is created using the Quick 
Portfolio window. It can be launched several ways, and contains five tabs:

 × Investments
 × Allocate
 × Annual Fees
 × Attributes, and
 × Report Options.

You do not need to enter information on every tab each time you create a portfolio. For 
instance, you can skip the Report Options tab altogether if you intend only to create a 
portfolio record (and do not need to immediately generate any reports for it). 

Only the Investments tab is required when creating a portfolio; all other tabs have 
default information entered on them.

To launch the Quick Portfolio window, do one of the following:

 × From the universal menu bar at the top of the screen (by selecting 
File…New…Portfolio)

 × From the Quick Start widget on the Home page, click the Portfolio link, or
 × Above the Groups, Clients, Portfolios or Model Portfolios spreadsheet areas, 

click the New Portfolio icon.

1

3

2

You have multiple options 
for creating portfolios
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Once the Quick Portfolio window is open, do the following:

1. On the Investments tab, select the securities to include in the portfolio. Note the 
following points when using the Investments tab:
 × Use the Select Universe drop-down field to change the type of investment 

you’re searching for.
 × In the Find field, you can look for most security types by either name or 

ticker symbol. The system automatically tries to find a match for your search 
string.

 × If the security you are searching for appears as you are typing its name or 
ticker, you can click once on its name to include it in the portfolio.

2. Once all of the investment you want to include are selected, select the Allocate tab.

When the name of the 
security you are looking for 
appears, click once on its 
name to select it
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3. On the Allocate tab, you can decided how to enter the amount for each security. A 
default value is automatically entered for each holding. As you update the allocation, the 
Asset Allocation View at the top of the screen updates automatically. You can also 
switch to seeing an Investment Style View, with the Morningstar Equity and Fixed-
Income style boxes.

Note the following points about using the Allocate tab:
 × You can allocate values by currency (dollars), Percentage or Shares. If 

you elect to allocate by Percentage, be sure to fill in the Total Value field 
with the full value of the portfolio.

 × For the price of each security, you can elect to use the most Recent 
month-end price, or the Most recent price.

 × You can change the order in which the securities appear by clicking on a 
column’s header. For instance, click once on the Name column header to 
sort the securities in alphabetical order. You can also use the far-left List 
Order column to set the order of the securities. Simply type the number of 
the row you would like an item to appear in, then click anywhere else on the 
screen, and the item will move. This can be an important consideration, 
because certain security-level reports you generate will accommodate only 
the first 10 securities. 

 × You can also indicate whether a position is a Long or Short position in a 
portfolio, or whether it was bought on Margin. Note that short positions 
affect the amount invested or the percentage allocated. 

Click here to choose whether
to use the most recent price
or the most recent 
month-end price for the 
securities in the portfolio
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4. It’s never too soon to save a portfolio; you can do this at any point while creating a 
portfolio. Now that the investments have been selected and the allocation set, it’s a 
good idea to save the work that’s been done. At the top of the window, click Save. The 
Save dialog box opens.

5. Decide whether to assign the portfolio to a Client or Group, or save it as a Model 
Portfolio. You can select the option button for the method you want, or you can simply 
click in the field to the right of To Group or To Client and start typing the name of a group 
or client; the option button will be selected automatically.

6. Type a name for the portfolio.
7. Click OK, then close the Save dialog box. You can now continue adding detail to the 

portfolio.

8. Click once on the Annual Fees tab. The Annual Fees tab is optional, but it allows you to 
enter a fee and determine how frequently the fee will be assessed throughout the year. 
The impact of the fee appears on the Portfolio Snapshot report; the ending value of the 
portfolio will be the same, but you can demonstrate the historical impact of the fee to a 
client.

If you want to save a 
portfolio as a model, be sure 
to select this option button

Use the Apply to All row if 
you are using the same fee
and frequency for all holdings
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9. Click once on the Attributes tab. The table below explains the options here.

Field Options

Tracking Method

You can set a portfolio’s value to be either Fixed or Floating. If it 
is Fixed, the dollar value will remain the same, but the number 
of shares owned will update. If it is Floating, the market value of 
the portfolio is updated regularly rather than remaining static.

Include in Totals
The options here are either Yes or No. If you do not want the 
value of this portfolio to count toward the total for a client, 
select No. 

Status

The options here are:

 × Actual
 × Historical
 × Proposed

For a Proposed or Historical portfolio, you might also want to 
set the Include in Totals field to No.

Portfolio Type

This field allows you to identify what type of portfolio you are 
creating. This allows you to create lists and searches for certain 
types of accounts, and can be particularly useful if you have the 
Investment Proposal tool with Wealth Forecasting. In the latter 
case, portfolios you identify as being 401(k) can be updated 
with matching contributions from a client’s employer.

If you want to include the 
value of the portfolio in the 
client’s or group’s total value, be 
sure to set this field to Yes
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10. Click once on the Report Options tab. If you do not intend to generate reports at this 
time, you can skip the rest of the steps, but you should click Save again before closing 
the Quick Portfolio window.

11. At the top, you can choose what to use for the portfolio’s benchmark. You can use a 
single index, or a composite benchmark comprised of several indexes. Selecting the 
Custom Benchmark option button allows you to create a blended benchmark using one 
of the following:
 × a benchmark you created in the Clients & Portfolios Module
 × an automatic benchmark the system creates based either on the asset allocation of 

the holdings, or the Morningstar Category they belong to, or
 × a benchmark you create by selecting the Independent Custom Benchmark 

option button, then clicking the view/edit link.

 If you use a custom benchmark, you can click the View link to see which indexes are being 
used, and how much is allocated to each.

12. The Select Asset Allocation Model drop-down field needs to be used only under the 
following two conditions:
 × You have created an asset allocation model you want to associate with the portfolio.
 × You intend to generate the Historical Asset Allocation and/or Target Asset Allocation 

reports. 

Click here to see the 
indexes used in 
the Autobenchmark
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13. Check the box next to the name of the reports you want to include in an output PDF.

14. In the Settings area, you can set the Font Size, Page Orientation and the order of the 
security-level reports, such as the Investment Detail Reports. The default option is 
Alphabetical, but you can elect to have them appear by Market Value, or by Interface 
order. 

 Remember, from step 3 on page 21, you can set the List Order for items in the portfolio, to 
manipulate the Interface order.

15. When you are finished, click Generate Report at the top of the window.

Check the box 
next to a report 
you want to include

Use the blue arrows 
to set the order in which
the reports will appear
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How does analyzing 
a portfolio in Principia 
compare with analyzing 
a portfolio in 
Advisor Workstation?

Principia had six different portfolio views, designed to give you six different ways to 
analyze your clients' portfolios. You could view Scheduled Portfolios in all of the views; 
you could not view Unscheduled Portfolios in the Scheduled Portfolio View.

The following table describes the options available from the View drop-down field 
in Principia:

This view.... Showed you...

Allocation

the dollar value, number of shares, and percentage allocations 
of your portfolio. In the Allocation View, you could create new 
Scheduled or Unscheduled Portfolios, add or remove holdings, 
set up new holding schedules, graph holdings, and view the 
Fund/Subaccount/Stock Detail report.

Scheduled

data relating to the portfolios investment history, including cost 
basis, taxes paid, capital gains and income distributions.

You could not view Unscheduled Portfolios in the Scheduled 
Portfolio View.

Snapshot

allocations, weightings and composition of the current portfolio, 
compared to Standard and Poor’s 500 index (the default 
benchmark). The Snapshot View included the following five 
subviews:

 × Composition
 × Style and Fundamentals
 × Stock Classification
 × Fixed-Income Style, and
 × Performance Indicators.

Database

all of the data columns common to the investment universes 
available in your Principia subscription. You could add or remove 
data columns from the Database View using the Layout 
function.

Alerts

changes in your clients' portfolios. For example, you could keep 
track of the Morningstar ratings of every investment in your 
practice. Alerts were applied at the Client, Portfolio, and 
Holding Level.

Stock Intersection
by percent assets, the underlying equity holdings in a portfolio. 
It demonstrated security risk if a portfolio is heavily invested in 
one security, or if several funds bought the same security.

Use the drop-down 
field to select a view
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From the Portfolios page in Advisor Workstation, the View drop-down field allows you 
to select options to analyze a client’s portfolio when you drill down on it.

The table below describes the View options in Advisor Workstation:

Select an option 
from the View field

View Description

Snapshot
The Snapshot section is similar to Allocation View in 
Principia. It displays Holding Status, Market Value, Portfolio 
Weight, and key data fields relating to the client’s portfolio.

Basics

This area is equivalent to the Database View in Principia. It 
presents information data fields common to Advisor 
Workstation’s mutual fund, ETF, and closed-end investment 
universes.

Composition

Information is displayed on two panes. The top panel, similar to 
the Snapshot-Composition area in Principia, reflects Cash, 
U.S. Stock, Bonds and ‘Other’ weightings. In the graph and 
table section, allocation to the classes is shown for long 
positions, short positions, and net (long positions net of short) 
positions.

Regional Exposure 
Use this area to break down the percentage of the portfolio’s 
assets invested in the United States and Canada, Europe, 
Japan, the Pacific Rim, Latin America, and other regions.

Morningstar Analysis

This section shows you columns related to key Morningstar 
proprietary data such as the Morningstar Rating, Rating 
Momentum, Analyst Rating, Morningstar Risk, Morningstar 
Return, and more.

Annualized 
Returns Current

Two graphs are displayed here. The Annual Returns graph 
calculates total returns based on a calendar year basis, while 
the Investment Activity graph visually displays the market 
value for a portfolio, based on the allocations made into the 
portfolio. The “as of” date is the most recent performance date 
available for the investment.
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Annualized 
Returns Monthly 

Two graphs are displayed here. The Annual Returns graph 
calculates total returns based on a calendar year basis, while 
the Investment Activity graph visually displays the market 
value for a portfolio, based on the allocations made into the 
portfolio. The “as of” date is the most recent month-end 
performance date available for the investment.

Return Monthly +/- Bmark.
This area displays return information related to the primary and 
category benchmarks assigned to the holdings in the portfolio. 

Annual Returns

The graph in this area shows total returns calculated on a 
calendar-year and year-to-date basis. Total return includes both 
capital appreciation and dividends. The year-to-date return is 
updated daily. The section below the graph provides NAV 
Return and Market Return for holdings in the portfolio.

Risk Analysis
This view displays data relating to MPT statistics, capture ratio, 
batting average and Sharpe Ratio, among other data fields.

Sector Exposure 

This view displays the percentage of stocks in the portfolio that 
are invested in each sector. It shows the percentage of the 
fund's net assets invested in each of the 11 major industry 
classifications and how this weighting compares with the 
current benchmark.

Equity Portfolio Analysis 
This view combines the style of the stocks in the portfolio with 
the style of the underlying holdings of the funds in the portfolio. 

Bond Portfolio Analysis

This view displays the portfolio’s underlying holdings effective 
duration and credit quality. It provides an overall representation 
of risk, given the length and quality of bonds in its portfolio. As 
with equity funds, nine possible combinations exist, ranging 
from short duration/high quality for the safest funds to long 
duration/low quality for the riskiest.

 Expenses

Working in this area allows you to examine costs related to the 
underlying holding in the client’s portfolio. You view expense 
ratio information as well as applicable loads, redemption fees, 
and 12b-1 charges.

View Description
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Working with Custom Benchmarks

OverviewThis section shows you how to work with custom benchmarks in Advisor Workstation. 
You will learn the following:

 × how to create a custom benchmark, and
 × the steps to assign a custom benchmark to a portfolio.

How does creating 
a custom benchmark 
in Principia compare 
with creating a 
custom benchmark in 
Advisor Workstation?

In Principia, custom benchmarks were used to blend indexes, proxies and category 
averages into a composite benchmark. To create the custom benchmark, you right-
clicked Custom Benchmarks in the Advisor Palette.

Advisor Workstation provides a simple workflow for selecting indexes and allocating 
weightings to them. In contrast to working in Principia, you can create a custom 
benchmark from the File menu of any area of the system. 

 Note: You need not be in the Clients & Portfolios Module to create a custom benchmark.

Custom benchmarks 
were stored here 
on the Advisor Paette
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How do I create a 
custom benchmark in 
Advisor Workstation?

To create a custom benchmark in Advisor Workstation, do the following:

1. From the File menu, click New...Custom Benchmark. The Custom Benchmark 
window opens.

2. From the Benchmarks tab, click the Select Universe drop-down field and select the 
universe in which you want to search.

3. In the Find field, enter a search term.
4. Click Find. Results appear in the Total Search Results box.

5. To select an item, click once to highlight it, then click Add. 

 Note: You can also select an item by double-clicking its name in the Total Search 
Results area.

Select this option from the 
File…New menu to create a 
custom benchmark from scratch

As you type, items appear
in the drop-down field
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6. Once you have all the desired items, click the Allocate tab.
7. Click in the % column and enter a percentage amount for each item. (All items must 

add up to 100%.)

8. When you are done, click Save. To save an existing custom benchmark as a separate file 
with a different name, click Save As.

9. Click the X icon to close the dialog box.

Use this field to apply
the same input for all 
values in the % column
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How does assigning 
a custom benchmark 
in Principia compare 
to Advisor Workstation?

In Principia, to assign a custom to a portfolio, you right-clicked an open portfolio file 
from the Advisor Palette and selected Assign Custom Benchmark. The Benchmark 
Preference dialog box appeared, and, from the From drop-down field, you selected 
Custom Benchmarks to view the benchmarks you created.

In Advisor Workstation, you can select from a list of standard benchmarks, assign a 
custom benchmark, or have the system create a custom benchmark for you (via the 
AutoBench feature) on the Report Options tab of the following windows:

 × Quick Portfolio
 × Portfolio Report Builder, and
 × Hypothetical Illustration.

The AutoBench tool was not available in Principia. In Advisor Workstation, this feature 
automatically creates a custom benchmark for a group of securities, based on the 
asset allocation of the portfolio, or the Morningstar Categories of the investments. 

In Principia, you selected 
a custom benchmark you 
created from this dialog box
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How do I assign 
a custom benchmark 
to a portfolio in 
Advisor Workstation?

To assign a benchmark to a portfolio, do the following:

1. From your list of portfolios, select the portfolio to which you want to assign a 
benchmark.

2. Click the Open/Edit icon on the toolbar above the spreadsheet area. (You can also right-
click on a portfolio and select Open/Edit from the menu that appears.) The Quick 
Portfolio window opens.

3. Click the Report Options tab.

4. In the Select Benchmark section, you have three options, as described in the 
following table:

5. Click Save and close the portfolio window.

After opening a portfolio, 
be sure to select this tab 
in order to choose a benchmark

Option Selecting this option means you can…

Standard Benchmarks select from a list of commonly-used indexes.

Custom Benchmark Tied to Library

click the drop-down field and select one of the 
following options:

 × AutoBench by Asset Allocation
 × AutoBench by Category, or 
 × one of your saved custom benchmarks. 

Click the View icon to see the underlying securities 
of a custom benchmark or an AutoBench.

Independent Custom Benchmark
create a custom benchmark on the fly by selecting 
this option button, then clicking view/edit icon to 
launch the Custom Benchmarks tool.
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Generating Portfolio Reports in Advisor Workstation

Overview This section explains how to create portfolio reports in Advisor Workstation. Note that 
in Advisor Workstation, you do not need to be in the Clients & Portfolios Module to 
create reports for portfolios; you can use the Portfolio Report Builder (available from the 
Reports menu at the top of the window, or the Quick Start widget on the Home tab) at 
any time.

Principia’s Portfolio mode allowed you to create the FINRA-reviewed Portfolio Snapshot 
Report. The report could be generated electronically, or printed to a hard copy.

Principia Advanced module users not only could generate the Portfolio Snapshot 
Report, but also the Portfolio Comparison Report and Client Position Reports. Advanced 
module users were also provide access to the Batch Reports tool, allowing for multiple 
portfolio reports to be generated at one time.

How do the reports 
available for 
portfolios in Principia 
compare with those in 
Advisor Workstation?

The table below illustrates which reports were found only in Principia, which are found 
only in Advisor Workstation, and which are available in both applications.

Portfolio Report Name
Available
in Principia?

Available 
in Advisor 
Workstation?

Cover Page Yes Yes

Portfolio Comparison Yes Yes

Portfolio X-Ray No Yes

Portfolio Snapshot Yes Yes

Portfolio Fact Sheet Yes No

Client Position by Portfolio Yes No

Client Position by Security Yes No

Client Level Snapshot Yes
Yes (known as the 
Aggregated 
Portfolio Report)

Stock Intersection No Yes

Correlation Matrix No Yes

Investment Details Yes Yes

Underlying Holdings Report No Yes

Price and Distribution Report No Yes

Target Asset Allocation No Yes

Historical Asset Allocation No Yes
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See the table below for information about each report.

Report Comments

Cover Page

By default, the Cover Page is selected. Clear this box if you do not 
want the cover page.

Note the following points about the cover page:

 × Report Title: Can be up to 100 characters long.
 × Client name: Can be up to 35 characters long.
 × Prepared By: Can be up to 35 characters long.
 × Prepared By Title: Can be up to 35 characters long.
 × Firm Name: Can be up to 35 characters long.
 × Date: By default, today’s date appears, but you can change it.

Portfolio Comparison

A PDF report that has been reviewed by FINRA. Check both the 
report’s header, and with your compliance department before leaving 
this report with a client. 

This report reveals the differences between any two portfolios. The 
report breaks down the comparison into eight categories: Asset 
Allocation Comparison, Morningstar Style Box Analysis, U.S. Stock 
Sector Analysis, Regional Exposure, Historical Returns, Portfolio 
Statistics, Modern Portfolio Theory (MPT) Statistics, and Portfolio 
Holdings.

Portfolio X-Ray

A PDF report that has been reviewed by FINRA. Check both the 
report’s header, and with your compliance department before leaving 
this report with a client. 

The Portfolio X-Ray Report is the most straightforward way to 
communicate a portfolio’s overall investment strategy to your clients. 
It boils down vast amounts of investment information into a clear, 
concise summary that can be grasped at a glance.

Note: The ending date for this report cannot be more than one year 
prior to the current date.

Portfolio Snapshot 
Report

A PDF report that has been reviewed by FINRA. Check both the 
report’s header, and with your compliance department before leaving 
this report with a client. 

Contains three pages of in-depth portfolio analysis, such as portfolio 
composition, investment style, sector weightings, regional exposure, 
performance numbers, market maturity, stock type weightings, and 
MPT statistics, and includes four graphs: Investment Summary, 
Investment Activity, Risk/Reward Scatterplot, and Performance 
History.

 × The ending date for this report cannot be more than one year 
prior to the current date. 

 × The time period for your Hypothetical Illustration must be at 
least 3 years for the Risk/Reward Scatterplot to generate on this 
report.

Stock Intersection

This report shows the 25 largest individual stock holdings in the 
portfolio, clearly displaying overlap between the same holdings in 
multiple funds.

Note: The ending date for this report cannot be more than one year 
prior to the current date.
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Correlation Matrix

The Correlation Matrix displays how closely related selected funds 
and stocks are to one another.

Note: In Principia, you could generate the Correlation Matrix graph 
while working in Portfolio Mode.

Investment Detail

This is the same report as you generated from Principia. This report 
contains the following main sections:

 × Performance
 × Portfolio Analysis
 × Fees and Expenses
 × Risk and Return Profile, and
 × Operations.

Underlying Holding 
Report

This report provides the underlying holdings of managed products. In 
evaluating a managed product, it can be instructive to consider the 
holdings of that product.

The report contains the following main sections:

 × Holdings Summary, and
 × Holdings Detail.

Price and Distribution

This report contains the following main sections for holdings in the 
portfolio:

 × Historical change in NAV, and
 × Historical income and capital gain data.

This report can be used to show how an equity fund’s value has 
steadily climbed over the years, or how a fixed-income fund has 
provided reliable, growing dividends.

Target Asset Allocation
This report illustrates the proposed allocation for your portfolio at a 
broad asset class level and a detailed, sub-asset class level.

Historical Asset 
Allocation

This report demonstrates how money invested in the asset allocation 
shown in the Target Asset Allocation Report would have performed 
over a long investing horizon and during two shorter-term periods of 
generally poor market performance.

Report Comments
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How does generating 
the Portfolio Snapshot 
report in Principia 
compare with opening 
the same report in 
Advisor Workstation?

Principia reports were generated from the Snapshot View of Portfolio Mode. You 
double-clicked a portfolio and from the File menu selected Generate Portfolio 
Snapshot (PDF). You could also click the Print icon from the toolbar to generate a 
hard copy.

To generate the Portfolio Comparison Report (PDF) in Principia, you highlighted two 
client files in the Advisor Palette, then from the File menu clicked Portfolio 
Comparison Report (PDF).

Select this option to open the
Porttfolio Snapshot Report (PDF)

Select this option to generate 
the Portfolio Comparison Report
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How does generating the Portfolio Snapshot report in Principia compare with opening the same report in Advisor Workstation? Generating 
Principia Advanced Module users were provided access to the following reports, 
available from the File menu:

 × Portfolio Comparison Report (PDF)
 × Client Position by Portfolio (PDF)
 × Client Position by Security (PDF), and
 × Client Level Snapshot (PDF).

In Advisor Workstation, you have three ways to generate reports for portfolios:

 × Use the Portfolio Report Builder (available from the Reports menu at the top 
of the window, or from the right-click menu), which allows you to create 
multiple reports for multiple portfolios at once.

 × From the menu bar at the top of the screen, select Reports...Portfolio 
Reports to select the report you want to see. 

 × Right-click on a highlighted portfolio and select the name of a report from 
the right-click menu.

You can generate reports from the menu bar,
or by right-clicking on a selected row.
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Other Differences Between Advisor Workstation and Principia

OverviewThis section reviews portfolio-related features you have access to in Advisor 
Workstation, but were not available or shown in Principia, and features you had access 
to in Principia, but are not available in Advisor Workstation.

What features are 
found in Advisor 
Workstation 
that were not 
available in Principia?

In Advisor Workstation, you have access to the following features, which either were 
not found in Principia, or work differently:

 × Unless you were a Principia Asset Module subscriber, you would not have 
access to Asset Allocation related tools and their reports. Asset Allocation 
tools and reports are provided by default in Advisor Workstation.

 × Unless you were a Principia Hypothetical Module subscriber, you would not 
have access to Hypothetical Illustration reports. The Hypothetical Module is 
included by default in Advisor Workstation.

 × Principia did not have the Stock Intersection Report, but it did have the Stock 
Intersection View, available from the drop-down field in Portfolio Mode.

What features were 
found in Principia 
that are not available 
in Advisor Workstation?

The following features were available in Principia, but are not available in Advisor 
Workstation:

 × Advisor Workstation does not have a Scheduled Portfolio feature. No 
transactional data can be entered in Advisor Workstation; only current client 
positions can be entered.

 × The Batch Reporting tool is not available in Advisor Workstation. You can, 
however, use the Portfolio Report Builder tool to generate multiple reports 
for multiple portfolios at once. 
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How do I use the Portfolio Mapping tool? Other Differences Between Advisor Workstation and Prin-
How do I use the 
Portfolio Mapping tool?

You can use the Portfolio Mapping tool to reassign a portfolio or portfolios to a new 
client, group, or model. 

To map one or more portfolios, do the following from the Portfolios page in the Clients & 
Portfolios module:

1. To select a single portfolio, click to highlight the portfolio, then right-click and select 
Portfolio Mapping (or use the menu bar at the top of the Advisor Workstation window 
to select File...Portfolio Mapping). The Portfolio Mapping dialog box opens.

 To select multiple portfolios, use <SHIFT>+click to select a range of portfolios. To select 
multiple non-consecutive portfolios, use <CTRL>+click.

2. In the Portfolio Mapping dialog box, the Current Assignment 1 column displays the 
current mapping for the portfolio(s). The Level column indicates whether this assignment 
is to a client, group, or model. The Current Assignment 2 column indicates the secondary 
client assignment for the portfolio(s), if applicable. To change a portfolio's mapping, click 
in the New Level column in the row for that portfolio and select Client, Group, or 
Model.

3. In the New Assignment 1 column, begin typing the name of the client, group, or model 
to which you want to map the portfolio. Suggestions appear below your entry. Click on 
the desired name.

4. If you selected Client in the New Level field, you can assign the portfolio to a secondary 
client in the New Assignment 2 column.

5. Once you have made your changes, click Save.
6. To close the dialog box, click Close.

Select this option 
from the File menu

This portfolio is currently mapped 
to a group, but you can use this 
field to assign it to a client
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